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Starting Virtument in MatDeck 
 

Please note: To use certain variable and values within MD documents in Virtument, they may need to be 

exported. Exporting and Importing values and variables is used in the example at the end.  

There are multiple ways of starting and using in Virtument in MatDeck. This includes: 

 Opening Virtument in MatDeck via “Virtument Toolbox” 

 Opening Virtument in MatDeck via “Virtument Form” 

 Virtument Instruments/Widgets via Canvas 

 Opening Virtument in MatDeck via Virtument functions 

Opening Virtument in MatDeck via “Virtument Toolbox” 

Before being able to use Virtument in MatDeck, its toolbox must be added first. To do this, go to the 

‘Toolbox’ toolbar at the top of the window and press on ‘Manage Icons’.  

 

The window below will appear, with all the possible toolboxes that can be added. To add Virtument, tick 

the check box for it under “Use” and press “Ok” to confirm. 
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Opening Virtument in MatDeck: once a Virtument toolbox has been added to MatDeck, Virtument is 

ready to be used. Simply open Virtument by pressing on the new button you have created for the 

Virtument toolbox. 

 

Once pressed,  an empty Virtument instruments panel in a separate window will open such as the one 

below. 
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Opening Virtument in MatDeck via “Virtument Form” 

Virtument instrument panels can also be opened by inserting a Virtument form into a canvas. This has 

the added benefit that the instruments panel can be used and incorporated directly into the MatDeck 

document.  

 

The Virtument panel will appear as so in the canvas. 

 

Please Note: To insert the Virtument panel, first make sure that your MD document is in A3 format. This 

can be done by going to the “Layout” tab, pressing on the “Paper Size” icon and selecting A3. 

First, go to the “Insert” tab and move to the Form tab towards the right. Here, select the 

“VirtumentForm” option from the second drop down menu. The Form should look like this. 
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 The form must be inserted into a canvas on the A3 document. To insert a canvas, simply go to the 

“Insert” tab and press on the Canvas icon. Now, press where on the document you wish to deploy the 

canvas. The Virtument instrument panel is larger than the default Canvas size so it is recommend to 

expand the canvas before adding the panel. 

Once the Canvas is set and the form is configured, press on the form icon and select where in the canvas 

you wish to deploy the Virtument instruments panel. The panel will be deployed as such. 
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Virtument Widgets via Canvas 

 

Specific Virtument instruments/widgets can be used outside the instruments panel and directly in the 

MatDeck document. Below is an example of an Analog Circular Gauge deployed in a MatDeck canvas. 

Here, by selecting the “Widgets” option from the first drop down menu, users can select a widget from 

the second drop down menu to insert in the canvas. 

 

By setting the “Select Form” tab as such, an Analog Circular Gauge has been selected. Press the 

“Widget” icon to initiate the widget and press where on the canvas you wish to deploy the widget. 

The function used will be stored in an auto-created variable. In this case, the variable is called 

“wgt18523”. 

 

Virtument widgets in MatDeck can be inserted two different ways. The example above was done by 

using the “Select Form”. 

 

Virtument widgets can also be inserted by directly writing the widget functions in the canvas. 
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Here, the function used for initiating an Analog Circular Gauge is stored in the variable, “Widget”, and 

the widget is named “ExampleWidget”. The function used only creates the widget but doesn’t deploy it 

into the canvas. This is where embed_widget() is used to deploy the widget instanlty in the canvas in its 

place. 
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Opening Virtument in MatDeck via Virtument functions 

Virtument can also be opened in MatDeck by using Virtument functions within canvases. Here, the 

Virtument panel will automatically open once the function has been written but can be embedded with 

the correct functions. 

 

In the example above, the function VirtumentForm() is used to initiate the Virtument instruments panel. 

Its only argument is the name of the Virtument instruments panel. In this case, “ExampleForm” is used. 

Similar to Virtument widgets, the function only creates the Virtument panel. The Virtument needs to be 

deployed by using another function. The panel can be either embedded in the canvas or deployed as an 

independent window. In this example, embed_widget() is used. 
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1 Instrument panel 
 

This is the main working area in which you can insert new instruments. 

Virtument can be accessed in multiple ways in MatDeck. The most common is through the Virtument 

toolbox but, Virtument can also be deployed directly into the document depending on the user’s 

preference.  Please read Starting Virtument in MatDeck to learn more. 

 

 

Picture 1: Virtument desktop 

When Virtument is open, the window above will open. This is the default empty Virtument window. 

The desktop consist of the following features: 

1. Instrument panel: main work area for adding new instruments and editing current instruments 

2. ToolBox: the window located to the side which allows you to choose and insert new instruments to 

panels, save and open panels, edit instruments settings, lock and unlock panels … 
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Picture 2: Instrument panel 

Scrolling and moving in the instrument panel: when first opened the Virtument window will be empty 

and the instrument panel will have no sliders for scrolling present. However, when new instruments are 

added and moved outside the starting area, vertical and horizontal sliders will appear which can be 

moved to transverse through the instrument panel. 

 

Picture 3: Horizontal slider 

By right clicking on the horizontal slider, it will open the 

content menu shown on Picture 3. From this menu, you can 

move the slider by choosing one of the available options. 

For example, if you press the ‘Scroll here’ option, the slider will 

position itself on the place where you have right clicked on. 

You can position the slider on the edges of the Instrument 

panel area with the ‘Left edge’ and ‘Right edge’ options. You 

can also move the slider one page to the left/right using ‘Page 

left/right’ or move it one scroll to the left/right using ‘Scroll 

left/right’. 



__________________________________________________Virtument 

 

11 
 

 

Picture 4: Vertical slider 

Another feature present on the instrument panel is the collapse toolbar button . This option allows 

you to hide the ‘Instruments’, ‘Panel’ and ‘Edit Selected’ features leaving only the main working area the 

instrument panel present. If you have hidden the toolbar and you wish to see it, simply press the button 

again to return to its original format. 

Right clicking on the working area of the Instrument panel will open the options below. 

 

Change Background Color opens the window shown in Picture 5 from which you can set the Instruments 

panel area background color. Default background color is gray.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                      

 

Similarly, pressing right click on the vertical slider will open 

the content menu shown on Picture 4. 

In respect to the content menu above, the options in this 

menu are the same but are for moving the vertical slider. 
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Picture 5: Background color 

 

Set Password allows users to set a password of their choosing to be used on the instruments panel. By 

pressing “Set Password”, the following window will open where users can type in their password and 

confirm by pressing “Ok”. Once set, every time the instruments panel is opened, the password needs to 

be inputted to unlock the panel and allow for editing. 

 

 

 

Inserting new instruments: to insert new instruments into the Instrument Panel, simply press on the 

instrument of your choice from the Toolbox and it will appear on the Instrument Panel in the upper left 

corner. From here, you can move and position the instrument to your preferred position by pressing and 

holding on the cursor on it. 
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2 ToolBox 
 

From this window, you can choose the preferred instruments that you want to place on the Instrument 

panel, save and open panels, edit and delete instruments, lock them, set a password for the editing and 

moving of instruments and delete all the instruments present in the Instrument panel. 

 

Picture 6: Settings ToolBox 

 

Load - When pressed will cause the opening of the Open content menu from which you can choose the 

destination folder and file you want to open.  
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Save - When pressed will open the Save content menu from which you can choose the destination 

folder where the current Virtument panel can be saved. Like standard content menus, it will allow you 

to change and save the name of the panel. Virtument documents (panels) are saved in a .vir extension. 

 

 

New – This can be used to open a new instruments panel in place of the current one. To retain your 

progress in the current instruments panel, a pop up window will appear asking if you wish to save your 

current panel. 

 

 

Exit – This can be used to close the current Virtument instruments tab that is open. If any instruments 

are present in the panel, a pop window will appear asking you whether you wish to save the panel 

before closing. 

 

 

Set Password – Here, a custom password can be set which locks the instruments panel when it is next 

open. A pop window will appear where you can type in your password of choice and press “Ok” to 

confirm. Now, the next time this panel is opened a password will be required to access and edit it. 
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Cut – Similar to standard “Cut” options, it will remove your selected widget to the clipboard. By pressing 

“Paste”, the selected widget will be deployed in the top left corner of the instruments panel. 

 

 

Copy – Similar to standard “Copy” options, it copies the selected widget to the clipboard without 

removing the original widget from the instruments panel. By pressing “Paste”, a copy of the selected 

widget will be deployed in the top left corner of the instruments panel. 

 

 

Paste – Similar to standard “Paste” options, it will output the clipboard’s contents to the top left corner 

of the instruments panel. 

 

 

Delete - Pressing on it will delete the selected instrument(s) from the Instrument panel. Becomes active 

when one or more instruments are selected. Before an instrument is completely deleted, a message 

window shown in Picture 7 will open, asking you to confirm this action. 

 

 

Picture 7: Delete confirm window 
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The first grouped tab on the right side of the instruments panel also includes additional widgets that can 

be added to the panel. By using the scroll tab, users can add in Pipes, Tanks, Valves, and Other widgets. 

These are especially useful for SCADA applications and allow users to represent and illustrate processes 

much more accurately and simpler. 
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Instruments 
 

In Virtument, you have 16 instruments at your disposal and the number of instruments that you can 

place on the Instrument panel is unlimited. Every instrument has a distinctive set of settings unique to 

them. Additionally, a common set of settings are present in all instruments. We will go through them 

first.  

List of instruments 

 Analog Circular Gauge  Analog Edge Gauge 

 Analog Horizontal Linear Gauge  Analog Vertical Linear Gauge 

 Horizontal VUMeter Gauge  Vertical VUMeter Gauge 

 Thermometer Gauge  Digit Meter 

 Switch  Indicator 

 Graph  Image 

 Text  Tank 

 Horizontal Slider  Vertical Slider 

Instrument Frame             Signal Generator 
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2.1 Context menu 
 

The Context menu is the same for every instrument in Virtument.  To open a Context menu, simply right 

click on the instrument of your choice. A menu of options like the one below will open. 

 

 

Picture 8: Context menu 

 

Instrument Type – This option when selected will open a drop down menu with all the instruments in 

Virtument (shown above). Here, you can change the current instrument you have selected to another of 

your choice by clicking on the instrument in the list you wish to use. 

Properties – When pressed, it will show all the possible properties of your selected instrument. A 

window with tabs will house all of the settings which you can change. The tabs present are each 

designated for a certain aspect of the instrument. The number tabs and settings vary with the type of 

instrument you are using. 

Please note: Editing and configuring a instrument’s channels is done through the instrument’s 

properties. 

Bring to Front –This option will move the selected instrument in front of all other instruments on the 

panel. This option will prove useful when two or more instruments are overlapping. 

Send to Back – This option will move the selected instrument behind all other instruments present on 

the panel. Like Bring to Front, this will be useful when two or more instruments are overlapping. 
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2.2 Instrument General Tab 
 

General tab is the default tab present in every instrument’s properties. It can be opened by selecting the 

option ‘Properties’ in the context menu that appears when you right click on an instrument. 

 

Picture 9: General tab 

Title group: From this group of settings you can edit all the properties related to the title of the selected 

instrument.  

This includes: 

 ‘Show Title’ – tick the checkbox to make the title of the instrument visible 

 ‘Title’ – this field contains the title text itself (by default the title is ‘Title’) 

 ‘Font’ – press on this for a drop down menu of fonts which you can choose from for your title 

 ‘Transparent Background’ – checkbox for whether you would like a background for your title 

 ‘Background/Text colour’ – colour options for the respective property 

Scada Tag – If you have setup a SCADA system this option will allow you to enter a tag which can be 

used to refer this instrument to your SCADA. 

Refresh Interval: This parameter is responsible for the time between instrument updates and is 

measured in milliseconds. For example, if the Refresh Interval is set to 2000, the instrument will have a 

delay of 2 seconds before it detects any changes in its source values.  
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2.3 Instrument Frame tab 
 

The ‘Frame’ tab is present in the following instruments: Analog Circular Gauge, Analog Edge Gauge, 

Analog Horizontal Linear Gauge, Analog Vertical Linear Gauge, Horizontal VUMeter Gauge, Vertical 

VUMeter Gauge, Thermometer Gauge, Digit Meter, Graph, Image, Text and Tank.  

From the Frame tab you can:  

Colour Setting – these settings concern all the colouring aspects of the instrument 

Includes: 

 ‘Show Frame’ – choose to show the instrument’s frame and its colour 

 ‘Show Background’ – choose to show the instrument background and its colour 

Frame Settings – settings that alter the thickness of the frame and the type of frame you wish to use. 

Frames available on instruments are unique and depend on the instrument you are editing. 

 

Picture 10: Frame tab  
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2.4 Instrument Scale tab 
 

The Scale tab is present in the following instruments: Analog Circular Gauge, Analog Edge Gauge, Analog 

Horizontal Linear Gauge, Analog Vertical Linear Gauge, Thermometer Gauge, Tank, Horizontal Slider and 

Vertical Slider. Scale tab is shown in Picture 11. 

 

Picture 11: Scale tab 

 

General group: From this group of settings you can choose if the scale will be shown, name the scale 

and set the scale colour. 
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Values group: From this group of settings you can choose if the scale’s values will be shown, set their 

start and end values, choose the number of decimal places for the values. The colour and size of the 

values shown below can also be changed. 

  

 

Steps group: From this group of settings you can choose the size of each step in your scale; 

  

 

Critical area group: From this group of settings you can choose if the critical area is shown on the scale 

or not and set its values; 

  

 

 

Please note: The examples and options shown in the scale tab above are for a slider instrument. Each 

scale tab will be unique and tailored more for the instrument you are editing. This means the scale tab 

will be the same for most instrument but slightly different for certain instruments. 
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Instrument specific tabs 

The following segment will focus different properties which are specific and unique to a certain 

instrument. The tabs available in the properties of the following instrument only apply to a select group 

of instruments. 

 

Button tab – Analog Circular Instrument 

 

The Button tab is unique and only present in the properties of the Analog Circular Instrument. This tab 

allows you to choose what type of button/pin you want to use at the bottom of the needle. The colour 

of the button can also be edited at the top of the tab. 

Note: Like the properties tabs explained above, to complete adding your changes press ‘Apply’ to add 

your changes in real time and ‘Done’ to finish. 

LED – VU Meter Instrument   

General – Here, you can change the width and height of the instrument itself as well as changing the 

colour of the ‘Normal’ area of the LED. ‘Normal’ means the group of values in the scale that is deemed 

safe. LED Line Width changes the actual width of each measurement mark/marking on the scale. 

Critical area – This group of settings allow you to change the colour and the starting value for the critical 

area of the LED’s scale. The start value of the critical area is the point at which any values above are 

critical and the critical area begins. Additionally, the checkbox ‘Show Critical Area’ allows you to choose 

whether or not you want your critical area to be visible. 

Caution area – The settings present are the same as for the Critical area but apply to the Caution area of 

the LED’s scale. This area is used to caution/warn the user that the value is approaching the Critical area. 
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Values – These settings are used for properties of the values on the scale. This includes: 

 Start/End Value – Changing the values of these parameters will change the starting and ending 

value on the scale of the instrument respectively 

 Step – This will change how much the scale increases. The difference between different 

measurement markings on the instrument 

 Value Colour – Change the colour of the values displayed on the instrument 

 Value Text Size – The size of the values present 

 Decimal Places – The number of decimal places present on the instrument’s values   

 Show Values – Check box for whether values on the instrument will be displayed 

Channels – This channels window is the same as the channels tab explained earlier in this manual. 
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Thermometer/Tank/Slider tab 

This tab applies to the Thermometer, Tank and Slider. This tab is unique to the mentioned instruments 

and coincidentally named after the instruments themselves. For each instrument, the tab is the same 

but contextualised to the selected instrument.  

 

The image above is the Thermometer tab for the Thermometer instrument. The Tank and Slider 

instrument have the same layout but changed to apply to them. 

Colour – This option remains the same for all of the instruments and is used to change the colour of the 

instrument’s main body 

The window below has all the different bodies/frames which can be used on these instruments. 

 

Switch tab – Switch Instrument 

The Switch tab applies only to the Switch instrument and is unique. 

Switch type – A drop down menu with all possible types of switches available in Virtument. All 4 options 

have the same settings except ‘Rotary Switch’ which has one additional settings unique to it. 

Channel name – Switches produce their own channel automatically and this is used to name the channel 

it produces. 
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Colour – This group of settings includes: 

Background – change the colour of the background (outer frame of the switch) 

On state – the colour of the switch’s toggle when it is on 

Off state - the colour of the switch’s toggle when it is of 

 

Switches – Window located at the lower end of the tab that contains all previously used switches. 

Pressing on a switch in the window will change the current switch to the one pressed. Note, ‘Apply’ 

must be pressed to see the changes. 

Generator tab - Signal Generator Instrument 

The Signal Generator instrument has two tabs in its properties. The first is a General tab which we have 

already gone through earlier. However, the second tab is unique and only present in the Signal 

Generator’s properties. Below is the Generator tab present in the Signal Generator’s properties. 
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The Signal Generator instrument is used to produce signal automatically using the parameters that are 

set. It can produce the following types of signals: Constant, Sine, Sawtooth, Triangular and square. 

Similar to the Switch instrument, this instrument produces its own channel automatically. You can name 

the channel by entering your preferred name in the ‘Channel Name’ field as shown above. 

The settings on the left side are in regard to the features of the signal being produced. This includes: 

Generator Rate – The frequency of the signal  

Minimum Value – The trough/lowest point of the signal 

Maximum Value – The peak/highest point of the signal 

Constant Value – The offset of the signal   

Generator Type – The type of signal which is to be used       

Instrument Frame Properties 

The Instrument Frame is a unique intractable instrument which can be placed and move like the rest of 

the instruments previously mentioned. However, the Instrument Frame differs in the fact that it doesn’t 

have a ‘Properties’ tab in its context menu. Instead, Instrument Frame has ‘Set Title Font’ and ‘Frame 

Thickness’.  

‘Select Title Font’ will open the window below. This group of settings will allow you to: 

 Change the font of the title text 

 Choose a font style – Normal/Bold/Italic/Bold Italic 

 Change the size of the text 

 Add effects to your text such as Strikeout and Underline 
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As you can see from the above image, the options also allow you to select a writing system of your 

choice. This will continue most writing systems in use today. 

Additionally, the Sample box to the side will house an example of what your current text settings will 

make your text look like. 

The other unique option present is ‘Frame Thickness’. This is a self-explanatory setting which can be 

used to change the thickness of the outline of your frame. 

Please note: Instrument Frame is an aesthetic option that can be used to house and label certain 

instruments in your panel as shown below. It can prove useful as a way to separate different 

instruments which may be used for different purposes and organise your Instrument Panel better. 
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2.5 Instrument Channel group 
 

This group of settings is common for all instruments that show or output values of any kind.  

The Instrument channel group applies to the following instruments: Analog Circular Gauge (Needle tab), 

Analog Edge Gauge (Needle tab), Analog Horizontal Linear Gauge (Needle tab), Analog Vertical Linear 

Gauge (Needle tab), Horizontal VUMeter Gauge (LED tab), Vertical VUMeter Gauge (LED tab), 

Thermometer Gauge (Liquid tab), Digit Meter (Display tab), Graph (Graph tab) and Tank (Liquid tab). 

From this group, you can select the server from which you are importing data from. If you want to 

connect your instrument to a channel created on the same computer (in MatDeck or Virtument on the 

same computer), leave the Select Channel Server checkbox empty (default state). If you are trying to 

connect the instrument to a channel that is created on another computer, tick the Select Channel Server 

and a new form will appear as shown below. Using this form, you should set the remote computer IP 

address (WAN address of router) and port to establish a connection and make the channel visible. 

 

Picture 12: Select Channel Server 

Horizontal and Vertical slider instruments export their values to the channel automatically. Their names 

are VSlider and HSlider as shown in Picture 13. 

 

Picture 13: Channel table 
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To establish a connection, you have to select the channel in the table under the Channels Table tab 

from which you wish to insert data from. Once you have chosen a channel, press the  button 

to finish. 

If you want to break the connection press the  button. 

From the Settings tab of the Channel group you can choose which data will be shown in the Channel 

table (Picture 14). By default all the columns are set to be visible. 

 

Picture 14: Channel settings 

 

To connect instruments inside Virtument, output instruments such as progress bar will display data 

from input instruments such as Horizontal and Vertical sliders. 

Alternatively, you can export the variable from MatDeck in the channel and connect the instrument in 

Virtument together. 

We will demonstrate both ways of connecting in the following examples. 
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2.6 Connecting Virtument instruments  

 

2.6.1 Connecting Virtument instruments using MatDeck script code 

 

Virtument can be used as a separate window or embedded in MatDeck documents. Additionally, 

Virtument instruments can be interacted with and edited using custom MatDeck script functions instead 

of using channels and exporting variables. Using Virtument instruments through MatDeck script may be 

preffered as it makes integration with other MatDeck features simpler. 

Virtument panels can be inserted in MatDeck documents in one of two ways. 

 Embedded Virtument applications via ‘Select Form’ 

 Embedded Virtument applications via custom Canvas Functions 

  

Embedded Virtument applications via ‘Select Form’ 

Embedded Virtument instruments will be displayed in the canvas you have selected and will be available 

to be used in the MatDeck document. To embed Virtument applications within MatDeck documents, the 

‘Select Form’ function needs to be used. 

 

First, insert a new canvas inside your MatDeck document. Once inserted, configure the ‘Select Form’ 

function. To configure it so that you can insert Virtument panels, select ‘All Forms’ on the first drop 

down menu and ‘Virtument form’ on the second. Below is an example of this. 

 

Once configured, press the ‘Form’ icon to initiate the selected form and press on the selected area of 

the canvas to place your form. Once done, an embedded Virtument form will appear. 

 

The function VirtumentForm() will first appear followed by the Virtument panel itself. 
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A Virtument form such as the one above will appear in the canvas. 

 

Embedded Virtument applications via Canvas Functions 

Virtument panels can also be embedded by using the same Canvas functions. This method uses the 

same Canvas functions without the use of the ‘Form Selector’. Instead, the user manually writes the 

function necessary for embedding the Virtument panel. 

The user need to write the function VirtumentForm() which is used to start the form and has only one 

argument, the name of the panel in string form. The function needs to be stored in a variable which will 

be used later to embed the Virtument panel. 
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In the example above, the function embed_widget() will place the Virtument panel in the MatDeck 

document. Once embed_widget() is written, the Virtument panel will automatically appear and replace 

the function . 

2.6.2 Example: Connecting Virtument instruments 

 

Create two instruments and connect them to the Slider.  Use the Multiply options for one of them, so 

displaying the instruments doesn’t show the same values. 

Method: Press the Analog Circular Gauge icon  and it will appear in the top left corner of the work 

area. Press the Digit Meter icon  and it will also appear in the top left corner of the work area. To 

move the instruments, float your cursor over the instrument. Then, press and hold on the instrument to 

move it. Once you are satisfied, press the Vertical Slider icon  and add it onto the instrument 

panel. 

Right click on the Analog Circular Gauge 

and from the context menu choose Edit. 

Go to the Needle tab and in the 

Channels table select VSlider (the only 

channel in the table through which the 

values of the Vertical Slider will be sent) 

and press the Select button. At the end, 

press the ‘OK’ button to confirm the 

changes. 

 

 

Now, repeat the procedure with the 

Digit Meter instrument. Right click on 

the Digit Meter and from the context 

menu choose Edit. Go to the Display tab 

and in the Channels table select VSlider 

(the only channel in the table through 

which the values of the Vertical Slider 

will be sent) and press the Select 

button. Set the ‘Multiply’ value to 2.5.  
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Make sure that you press ‘OK’ to confirm all the changes that have been made. 

All you have to do now is to change the Vertical Slider’s value and watch the values of the other two 

instruments change. 

   

Picture 15: Example 1 

 

2.6.3 Example: Connecting Virtument instruments through MatDeck 

 

Create one Slider instrument and one other instrument to display the values. Send the data from Slider to 

MatDeck which process them and sends the data back to Virtument displaying instrument. 

Method: Press the Analog Circular Gauge icon . It will appear in the top left corner of the 

instrument panel. By pressing and holding on the instrument, you can move the instrument and position 

it. Next, press the Vertical Slider icon  . Like the Analog Circular Gauge, you can position it using the 

same method. 
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Once done, go to MatDeck and insert a Canvas . Canvas is located in the ‘Insert’ tab at the top of the 

window. Type a:=0 to define the variable a with an initial value of 0. Next, add a= in a new line so you 

can check the value of the variable a, it should be 0. On a new line, type b:=sin(a) to define the variable 

b with a value of sin(a). Lastly, add b= on a new line to display the value of the variable b. It should be 0. 

 

From the ‘Data’ tab at the top, press the Import icon  

and place it on the canvas. Right click on it and from the 

context menu that appears select ‘Properties’. A new 

window will open. Press the ‘Add Variable’ button on the 

top and a new table with available channels will open. Click 

on the ‘HSlider#1’ row in the table and press select. Next, 

choose the variable a from the Write to Variable field. 

Once done press ‘Close’ to finish. We have now just 

imported the Horizontal Slider’s values to the variable a. 

Press the Export icon  in the ‘Data’ tab and place it on 

the canvas. Right click on it and from the context menu 

select Properties. A new window will open. Select the 

variable b from the Document Variables field and press 

Add and then Close at the end. We have just exported the 

variable b’s values to the channel.  

  

Now that we have connected the Analog Circular instrument to b’s channel it will display the variables 

values. As the variable b is the sin of a which is also connected to the Vertical Slider, the Analog Circular 

Return to Virtument and right click on 

the Analog Circular Gauge, from the 

context menu choose Properties. Go 

to the ‘Needle’ tab and in the 

Channels table select the Variable b 

(the variable we have sent to the 

channel from our MatDeck document) 

and press the Select button. 
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instrument will display the sine of the value on the slider. However, the sin of a only fluctuates between 

1 and negative 1. To make the Analog Circular instrument’s changes in value more noticeable we will 

multiply the values by 10. This means the min and max values of the Analog Circular instrument will no 

longer be -1 and 1 but -10 and 10. This will make the changes in the slider’s values and their sin values 

more noticeable. 

 

To do this, we will simply go to the channels settings group in the ‘Needle’ tab of the instrument’s 

properties. The Multiply field of the settings will be set to 1.00. Change it by simply writing in 10.00 or 

pressing the upwards arrow. Now, all the values that the Analog Circular instrument receives will be 

multiplied by 10 and then displayed. In the Scale tab of the Analog Circular instrument and in the Values 

group, set the ‘End value’ to 10 (it will display the value of the variable b multiplied by 10. b is defined as 

sin (a) and its values will not go above 1 so, the instrument will not go above 10 and negative 10). To 

finish, press the ‘OK’ button to confirm the changes. 

 

As the sin function is used for angles, we must set the slider to range from 0 to 360 degrees. This can be 

done by changing the end values in the value settings located in the Scale tab of the slider’s properties. 

Once we have set the end value of the slider to 360, we need to change the markings on the slider. 
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Finish adding the changes to Vertical Slider instrument by pressing the ‘Done’ button at the bottom of 

the Properties window.  

Now, when you change the Horizontal Slider’s value, the value on the Analog Circular Gauge instrument 

will display the sine value of the slider multiplied by 10.  

 

Picture 16: Example 2 

By default, the slider’s markings will go up by 20 each time. As 

we have changed the slider’s end values to 360, we must also 

change the amount its markings increase by. In the same scale 

tab as earlier, we will change the Main Step Frequency of the 

slider to 45 instead of 20. This now means that the 

measurement markings on the slide of the slider will go up in 

multiples of 45, not 20. 


